BDE-MB1354P102 Module User Guide (BYE

BDE-MB1354P102 Module User Guide

V1.0

BDE Technology Inc. 1/ 47 info@bdecomm.com



BDE-MB1354P102 Module User Guide BOE
Contents
R CTCT =T = D 1Tl T o) o ] o I PSRRI 3
2. Launchpad Evaluation Module: BDE-LPEM .........ueiiiiiiiiiiiiiiieeeciieee s stttee sttt e e st e e s svae e e s ssteeessabaeeessseeeessnsanessans 3
3. Breakout Board: BDE-IMIBL13-BO......ccccuiiiieiiiieiiiieeessitee e sttt e e s sttt e e ssteee e s sbaeeessstaeessssaeeessstaeessasseeessnssenessnssenessnns 4
3.1. Breakout Board Header Pin ASSIZNMENT......ciiciiiiiiiiiie et eeieee sttt e sttt e e svee e e s ssatae e s sateeesssnteeessneaeessans 4
3.2. Debug Header Pin ASSIZNMENT ......ccuiiiiieiiee ettt e e sttt e e st e e s sbee e e s sbaeeeesbteeessbaeeessnsaeassassanessnns 6
O L= [T =) = (=T o SRR 7
o I o =T = To [ U1 £ L =TT PP PP PPPTPR PP 7
I R o T o 1Y T = UPSPI 7
Yo T V= T =3 o Vo I oo 3 USSR 7
I o Yo NN [ I =L AU PR 8
e B oY ATV T I Y=Y ] o PR 8
4.3.1. DownIoad and INSTAll CCS .......uviiiiiiiee ettt stre e e s e e s aba e e e enataeeesnsaeeesnnnseeen 8
4.3.2. DoWnNIoad and INSTAll SDK.........ueiiiiiiieeiiiiee ettt e et e e ree e e sire e e e sbree e e snbeeeesnreeesenasees 12
A A, BLES-STACK ..ttt e e e e e e et e ta b e e e e eeeaa et e e eeeeeeett b e eeeeeeaat b e e eaeeaeebaaaaeaaaaans 15
4.4.2. IMPOrt ProjeCt iNTO CCS ....uiiiiiiiiiiiiiiteeee ettt et e e e s s s sttt e e e e e s s seaareeeeeeesssasasraaaeeaesnns 16
4.4.2. MOdify XOSC Cap SELLING ..eeiiiiiiiiieiiiie ettt ettt eree e esee e st e e e s e e e s abee e e s sbeeeessbeaeessareeessnnsens 18
4.4.3. Modify RF SWitch Configuration .........coiciiiiiiiiiie et e e e s aree e e 18
4.4.4. Build and DOWNIOA PrOJECE .....uviiiiiiieciiie ettt ettt e e s e e e s abe e e e s nbae e e e enbes 21
4.4.5. RUNNING the DEMO....iiiiiiiieecee ettt et e e e e e e st e e e st e e e e sssbeaeesanbeeeeanareeesennsees 22
4.5. Host_test Project & BLOOl SOfIWAIrE ......ccocciiiiieiee ettt e e s e e s abee e e e aees 25
R N Y Y I 1 G UPPPTPPRR RPN 28
4.6.1. IMPOrt Projects iNTO CCS....uiiiiiiiiiiiiiiieeee ettt e e e ssiirre e e e e s s sssaabtr e e e e e e s sssabnbaaeaeeessssssnreaaeeessnns 28
4.6.2. MOdify XOSC Cap SELLING ..eeeiiiiieieeiiiie ettt ettt et e e et e e e bee e e s aae e e s ssbaeeesnbaeeesnraeesennsees 31
4.6.3. Modify RF SWitch Configuration .........coociiiiiiiiiie et e e e s e e e arae e s e 31
4.6.4. Build and DOWNIOA PrOJECE .....uviiiiiiiieciiie ettt tee e e e e e bee e e s aba e e e s nbae e e e ennees 34
4.6.5. RUNNING the 0EMO ...eiiiiiiieccee e e et e e e st e e e s st e e e e e eabaeeeenabaeeeennsees 36
4.6.6. Change to @ DIfferent PHY ...ttt et bee e s abe e e e abae e e e earees 39
4.7. Use UniFlash to DOWNIOAd FIrMWAIE .......cooiiiiiiiiiiiieeeieeeriee sttt ste e site e sbe e ssaaeesabeesbeeesaneesnes 39
4.7.1. Configure UNIFIAsh......ooeiiiieec ettt et e s e e e s st e e e s s nbaee e eabaeeeennnees 39
B.7.2. PrOSIAMIMING ..uuiiiiiitieiiiiiiiiteeeeeeesssiitreeeeessesssuretteeeesssssasstsaeeeesssssssssssaeeesssssssssesseeeesssssssssseeeeesens 40
4.8, SMATTRF™ STUIO c.uvtiiiiieiiie ettt ettt ettt e st e e st e sbe e s bte e sabeeesbbeesabeesabeeesabeesbaeensseesbeeesaseesases 41
4.8.1. CoNNECE 10 the MOTUIE.....ccuiiiiiieieeee ettt e st sbe e e ste e sbeeesabeenas 41
4.8.2. Change the Default SETLINGS ......ciiiiiiiieiiee e e e e e e e e abae e e e sarees 42
4.8.3. PEIfOIM RF TSt .cuuiiiiieiiitteiiee sttt ettt sttt st e st te e sabeesaba e s bteesabaeesbseesstaesabeeesabaesnsaeenssaessaeenaseenns 44
D OTNEI RESOUICTES ..eiiiiiiiiee it ettt sie ettt stt e ettt e s bt e e tbe e sabe e s bt e e sabaesabaeessbeesabaeesabaesasaesabeesabaeesabaesabaessseesasaeensseenns 45
oI Co I gl = oY (o] o s o - o o PR 45
7. REVISION HISTOMY ettt sanann 46
8. AdditioNal INFOIMATION ...eeiiiiieie ettt e s e st e st e e sbe e ssabe e s baeesabeesabaesaabeesbaeenareenas 46
8. L. TFAUEIMAIKS «.eeeeiiee ettt ettt ettt sttt s e s bt e e stte e s bt e e sabeesabeesbteesabeeebbeesabeesabaeesabeesbaeensbeesbeeesabeesases 46
Important NOtiCe and DiSCIAIMEY .......uuiii et e e e e e e e st e e e e sbe e e e e abe e e e esabeeeeesabteeeesabeeesennsees 47
167 ] 01 = Lot ST OPPTPPPTTR 47

BDE Technology Inc. 2/ 47 info@bdecomm.com



BDE-MB1354P102 Module User Guide LB})E*

1. General Description

This user guide is intended to assist the users in evaluating the module by providing instructions on how to
effectively use the evaluation kit.

The BDE-MB1354P102 is a multi-band Sub-1GHz and 2.4GHz wireless module supporting Thread, Zigbee®,
Bluetooth® 5.2 low Energy, IEEE 802.15.4g, IPv6-enabled smart objects (6LoWPAN), mioty, Wi-SUN, Amazon
Sidewalk, proprietary systems including Tl 15.4-Stack (Sub-1GHz and 2.4GHz), and concurrent multiprotocol
through a Dynamic Multiprotocol Manager (DMM) driver.

The kit includes a breakout board with module (board number: BDE-MB13-BO), a Launchpad™ evaluation
module which can connect with the breakout board through the BoosterPack™ interface (board number: BDE-
LPEM), and also a XDS110 debugger used for debugging BDE-MB1354P102 device (board number: BDE-XDS110).

2. Launchpad Evaluation Module: BDE-LPEM

The BDE-LPEM is an evaluation module designed as an interface module with BoosterPack interface which can
connect with any boards that come with the standard BoosterPack interface, including the BDE-MB13-BO board.
For more details on the BoosterPack pinout standard, please refer to this link.

The board overview is shown as Figure 1.
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Figure 1. Board Overview of BDE-LPEM
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3. Breakout Board: BDE-MB13-BO

We provide a breakout board for module to enable easy access to every exposed pad on module with the
2.54mm-pitch pins. The breakout board can be stacked to the BDE-LPEM board for evaluation.
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Figure 3. The Photo of BDE-LPEM Stacked with the Breakout Board with Module
3.1. Breakout Board Header Pin Assighment
Table 1 shows the pin assignment for breakout board header J1, J2, J3 and J4.

Table 1. Breakout Board Headers Pin Assignment
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Pin Number | Pin Name Type/Direction | Description

1 3v3 Power Board power supply, connect with module VDD through a ferrite
bead

2 DIO23 I/0 GPIO

3 DIO12 1/O GPIO, module RX in BoosterPack pin

4 DIO13 1/O GPIO, module TX in BoosterPack pin

5 DIO22 I/0 GPIO

6 DI024 I/0 GPIO

7 DIO10 I/0 GPIO, SPI_CLK in BoosterPack pin

8 NC - No connect

9 DlO21 I/0 GPIO, 12C_SCL in BoosterPack pin

10 DIOS I/0 GPIO, 12C_SDA in BoosterPack pin

11 NC - No connect

12 DIO14 I/0 GPIO, Button 2 in BoosterPack pin

13 DIO15 I/0 GPIO, Button 1 in BoosterPack pin

14 DIO8 I/0 GPIO, SPI_MISO in BoosterPack pin

15 DIO9 I/0 GPIO, SPI_MOSI in BoosterPack pin

16 nRST Input Reset pin, active low

17 NC - No connect

18 DIO11 I/0 GPIO, SPI_CS in BoosterPack pin

19 DIO19 I/0 GPIO

20 GND GND Board ground

21 NC - No connect

22 GND GND Board ground

23 DIO25 I/0 GPIO

24 DIO26 I/0 GPIO

25 DIO027 I/0 GPIO

26 DI028 - No connect

27 DIO29 - No connect

28 DIO30 I/0 GPIO

29 NC - No connect

30 NC - No connect

31 DlO17 I/0 GPIO

32 DlO16 I/0 GPIO

33 TCK - TCK for JTAG/XDS110

34 T™MS - TMS for JTAG/XDS110

35 NC - No connect

36 DIO18 I/0 GPIO

37 NC - No connect

38 DI020 1/O GPIO, PWM/GPIO in BoosterPack pin

39 DIO6 I/0 GPIO, RED LED in BoosterPack pin

40 DIO7 I/0 GPIO, Green LED in BoosterPack pin

BDE Technology Inc.
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3.2. Debug Header Pin Assignment
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Figure 4. Debug Header

Table 2 shows the pin assignment for the debug header.
Table 2. Debug Header Pin Assignment

Pin Number Pin Name | Type/Direction | Description

1,2,8,14,20 GND GND Board ground

3 5V Power 5V supply from XDS110

4,6,12, 16, 18 NC - No connect

5 3v3 Power Module power supply

7 RXD Input Module UART RXD

9 TXD Output Module UART TXD

10 SwWo I/0 SWO for JTAG

11 nRST Input Reset pin, active low

13 ™S I/0 TMS for JTAG/XDS110, or SWDIO for SWD debug
15 TCK I/0 TCK for JTAG/XDS110, or SWDCK for SWD debug
17 TDO I/0 TDO for JTAG/XDS110

19 TDI I/0 TDI for JTAG/XDS110

BDE recommends using XDS110 for the debug. J-Link or other debuggers support SWD could also work.

Figure 5. BDE-XDS110

BDE Technology Inc.
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The board can also be connected via a 2x5P 1.27-pitch ribbon cable to the XDS110 debugger.

4. Getting Started

Below section describes how to set up the development environment of BDE-MB1354P102xx module, including
the hardware and software.

4.1. Prerequisites

4.1.1. Hardware

e BDE-MB13-BO, breakout board with module BDE-MB1354P102xxx, depending on what module variant you
are choosing;

e BDE-LPEM, Launchpad evaluation interface module;

e BDE-XDS110, XDS110 debugger;

e USBtype Ccable;

e PC

4.1.2. Software and Tools

e Code Composer Studio
e SIMPLELINK-LOWPOWER-F2-SDK
e SimplelLink Connect mobile app

e UniFlash
e SmartRF Studio
e PuTTY

BDE Technology Inc. 7147 info@bdecomm.com
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4.2. Hardware Setup

1. Plug BDE-MB13-BO into the BDE-LPEM evaluation module and connect BDE-LPEM to BDE-XDS110, as shown

in Figure 6;
2. Connect the jumpers as shown in Figure 6;
3. Connect the BDE-XDS110 to the PC via a USB type C cable. The XDS110 will power the module with 3.3V if the

jumper on BDE-XDS110 is plugged to XDS.

Figure 6. Hardware Setup

4.3. Software Setup

4.3.1. Download and Install CCS

1. Visit the following link.
https://www.ti.com/tool/CCSTUDIO
2. Find CCSTUDIO item, and click “Download options”.

Downloads

IDE, CONFIGURATION, COMPILER OR DEBUGGER
CCSTUDIO — Code Composer Studio™ integrated development environment (IDE)

Supported products & hardware A Notifications

3. Choose the target platform, in this case, Windows is selected.

BDE Technology Inc. 8 /47 info@bdecomm.com
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Downloads  Supported products & hardware

4 Windows single file (offline) installer for Code Composer Studio IDE (all features,

devices) — 025037 K MD5 checksum  03bed76dcd6af85babds789c6500d70f (R
& Linux single file (offline) installer for Code Composer Studio IDE (all features,

devices) — 1017375 K MD5 checksum  3bB5c52574e07f18028b3f406d28d266 R
4 mac0s single file (offline) installer for Code Composer Studio IDE (all features,

devices) — 1132582 K MDS5 checksum  dda2478c5250cf79e877c94136177211 (R

4. Decompress the zip file, and double-click “ccs_setup_xx.exe”.

Mame

components
G ccs_setup_20.1.0.00006
|Z| timestamp

5. Click “Next”.

i Code Composer Studio Setup

Code Composer Studio Setup - CCS 20.1.0.00006

Welcome to the CCS 20.7.0.00006 Setup Wizard.

89

code composer™
STUDIO

< Back

Cancel

6. Select “l accept the agreement”, and then click “Next”.
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7.

8.

G Code Composer Studio Setup —

License Agreement Q

Please read the following License Agreement. You must accept the terms of this agreement before continuing with the installation.

TECHNOLOGY SOFIWARE PUBLICLY AVAILRELE

Copyright (c) 201€ Texas Instruments Incorporated
211 rights reserved not granted herzein.
Limited License Agreement.

This Limited License Agreement ("Rgreement™) is a legal agreement between you (either an indiwvidual or
entity) and Texas Instruments Incorporated ("TI"™). The "Scftware" consists of the following materials: (a)
the materials identified as TI proprietary software programs in the software manifest for the software
subject to the terms herein, and any "on-line" or electronic documentation associated with these programs, or
any portion thereof (the "Licensed Materials"™), and (b) the materials identified as open source materials or
third party proprietary software in the software manifest for the Software, or any portion thereof ("Public
Software™). For clarificatiom, your use of the Licensed Materials is subject to the licensing terms
contained in this Agreement and your use of the Public Software is subject to the separate licensing terms
specified in the applicable software manifest and/or identified or included with the materials to which they
apply. This Agreement does not limit your rights under, or grant you rights that supersede, the license

Do you accept this license? I =
4 3 (O I do not accept the agreement

< Back | Mext > I Cancel

Click “Next”.

§P Code Composer Studio Setup — X

Please read the information carefully to determine if you need to take any action prior to continuing. h

Operating System Check -> OK

Installer Path Check -> OK

Unicode Character Check -> 0K

Anti-virus Check -> We have detected you are running anti-virus software on this computer. Anti-virus real-time file scanning may interfere with
installation and it is recommended you temporarily disable this feature. Anti-virus software may also block the downloading of files that occurs
during installatien. If you cannot disable the anti-virus software, we recommend the offline installer, which has less interference.

< Back Cancel

Choose the installation directory, and then click “Next”.

BDE Technology Inc. 10 / 47 info@bdecomm.com




BDE-MB1354P102 Module User Guide

§P Code Composer Studio Setup —

Installation Directory

Please specify the directory where CCS 20.1.0.00006 will be installed.

Installation Directory

| g

9. Select “Wireless connectivity” components, and then click “Next”.

&8 Code Composer Studio Setup —

Select Components

Select the components you want to install; clear the components you do not want to install. Click Next when you are ready to continue,

] MSPMO Arm® Cortex ®-MO+ microcontrollers Click on a component to get a detailed description
] MSP430™ microcontrollers

C2000™ real-time micrecontrollers

L Arm®-based processors

[[] AM2x Arm @-based high perfermance microcontrollers
[ mmWave Sensors

[] Hercules™ Safety MCUs

[ TM4C12x Arm® Cortex @ -Md4F MCUs

[ ceooo Power-Optimized DSP

[] OMAP-L1x DSP + Arm3™ Processor

[] SimpleLink™ MSP432™ low power + performance MCUs
[] PGA Sensor Signal Conditioners

[J uco Digital Power Controllers

10. Click “Next”, and the installation will start. Wait until the installation is complete.

BDE Technology Inc. 11/ 47
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§9 Code Composer Studio Setup

Ready to Install uoﬂ

Setup is now ready to begin installing CCS 20.1.0.00006 on your computer.

< Back Cancel

11. Click “Finish”.

§P Code Composer Studio Setup

Completing the CCS 20.1.0.00006 Setup Wizard

Setup has finished installing CCS on your computer,

Create Desktop Shortcut
[ Launch CCS

89

code composer™
SsTUDIO

< Back | Finish | Cancel

4.3.2. Download and Install SDK

1. Visit the following link.
https://www.ti.com/tool/download/SIMPLELINK-LOWPOWER-F2-SDK

2.  Find “SIMPLELINK-LOWPOWER-F2-SDK"” item, and click “Download options”.

BDE Technology Inc. 12 | 47 info@bdecomm.com
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SOFTWARE DEVELOPMENT KIT (SDK)
% SIMPLELINK-LOWPOWER-F2-SDK — SimpleLink™ Low Power F2 software =

development kit (SDK) for the CC13x1, CC13x2, CC13x4, CC26x1, CC26x2 and
CC26x4 devices A Notifications

The SimpleLink™ Low Power SDKs support the CC13xx, CC23xx and CC26xx family of products. Together, these SDKs
provide comprehensive software packages for the development of Sub-1 GHz and 2.4 GHz applications including
support for Bluetooth® Low Energy, Mesh, Zighee®, Matter, Thread, 802.15.4-based, (...)

Supperted products & hardware

3. Choose the target platform, in this case, Windows is selected.

Downloads  Supported products & hardware

4 windows Installer for SimpleLink CC13XX CC26XX SDK — 817328 K

Checksum 6bfgbfod0ed1dbedf3ae256f127aeeff ™

I«

Linux Installer for SimpleLink CC13XX CC26XX SDK — 841416 K
Checksum 9e8c13c6120f4f5f7f0854b7127d824b Fn

I«

Mac 08 Installer for SimpleLink CC13XX CC26XX SDK — 798418 K
Checksum 2cbf4c3a2e2d703a0d4b5ac3195d14fc I

I«

windows Zipfile for SimpleLink CC13XX CC26XX SDK — 1591218 K
Checksum dc5699f56b18e50d4e5f8ddcag0ddede I

I«

Mac 08 Zipfile for SimpleLink CC13XX CC26XX SDK — 1578922 K
Checksum 2c5f6183848bc138d31d0db6fa3720ds Fn

I«

Linux Zipfile for SimpleLink CC13XX CC26XX SDK — 1605828 K
Checksum 1c8f736a65326a65bb39406dd9d1ba77 I

4. Double-click the installation package.
5. Click “Next”.

* Setup — O >

Setup - Simplelink Low Power F2 SDK 8.30.01.01

Welcome to the Simplelink Low Power F2 SDK 2.30.01.01
Setup Wizard.

< Back Mext = Cancel

6. Select “l accept the agreement”, and then click “Next”.
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* Setup — O >

License Agreement ”

Please read the following License Agreermnent. You must accept the terms of this
agreement before continuing with the installation.

e
Copyright (c) 2015-2024, Texas Instruments Incorporated
211 rights reserved not granted herein.
Limited License.
Texas Instruments Incorporated grants a world-wide, royvalty—free,
non—-exclusive license under copyrights and patents it now or
herseafter e

I@ ‘| accept the agreement; I

Do you accept this license?
| do not accept the agreement

< Back Mext = Cancel

7. Choose the installation directory, and then click “Next”. Make sure the installation directory does not include
non-ASClI characters or spaces.

* Setup — O >

Installation Directory ”

Please specify the directory where Simplelink Low Power F2 SDE 8.30.01.01 will be installed

The following directories will be created in this directory:

simplelink_ccl3xx_cc2Bxx_sdk_8_30_.01_0
sysconfig_1.21.1
xdctools_3_62_01_15_core

Installation Directory

< Back Mext = Cancel

8. Click “Next”, and the installation will start. Wait until the installation is complete.
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* Setup — O x

Ready to Install ”

Setup is now ready to begin installing SimpleLink Low Power F2 5DK 8.30.01.01 on your
computer,

< Back Cancel

9. Click “Finish”.

Completing the Simplelink Low Power F2 SDK
8.30.01.01 Setup Wizard

INSTRUMENTS

Setup has finished installing SimpleLlink Low Power F2 5DK
8.30,01.01 on your computer,

< Back

4.4. BLES5-STACK

This section describes how to use the BLE5-Stack projects with CCS.

The BLE5-Stack examples are located at
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30_01_01\examples\rtos\LP_EM_CC1354P10_6\ble5stack

BDE Technology Inc. 15 | 47 info@bdecomm.com
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4.4.1. Import Project into CCS

1. Open the CCS IDE.
2. Go to File -> Open Folder.

File Edit " \ Go Project Run Scripts Terminal Help

@

Ctril+N
Ctri+Alt+N

New Fo

Open File... Ctri+0
Open Folder... Ctrl+K, Ctr+O
space from File... Ctrl+Alt+W

Ctri+Alt+R

Ctrl+5S

Ctri+Alt+S

3. Select a custom path as the workspace.

1] Open Folder %
U <« ccs_workspace » BDE-MB1354P102xx w 0 Search BDE-MB1334P102xx 2
Organize » Mew folder =z - 0
@& OneDrive *  Name - Date modified Type
[ This PC Mo items match your search,

J 3D Objects
] Desktop

= Documents
{ Downloads
J‘! Music

&= | Pictures

B videos

2. Local Disk (C)

< 2>

Folder: |

Select Folder Cancel

4. Go to File -> Import Project(s).
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File | Edit Selecti View Go Project Run Scripts Terminal Help

5 import Project(s

New Text File Ctri+N

Ctri+AR+N

)ser Stu

Ctrl+0
Ctrl+K, Ctrl+O
1+Al+W

Ctri+AR+R

zonnect your board

Ctrl+Alt+S

udio™ IDE

5. Click “Browse”, navigate to the “simple_peripheral” project folder. The default path is:
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30 01 _01\examples\rtos\LP_EM_CC1354P10_6\ble5stack\simple
peripheral

6. Select the project, and click “Finish”.

Import Projects

Search directory  C\ti\simplelink_cc1 263 _sdk_8 30_01_01\examples\rtos

overed projects

simple_peripheral_LP_EM_CC1354P10_6_tirtos7_ticlang

Create each projectin: BDE-MB1354P102xx v

Open * " to browse and import example projects

Cancel Finish

7. The “simple_peripheral” project will be imported into the IDE.
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* BDE-MB1354P102XX
w . simple_peripheral_LP_EM_CC1354P10_6_tirtos7?

> B3, Generated Source
» B3 application

» B3 common

4.4.2. Modify XOSC Cap Setting

The “XOSC Cap Array Delta” parameter will impact the radio frequency offset. An inappropriate value can affect
the RF performance. Follow the steps below to set the value that fits the module.

1. Open “simple_peripheral.syscfg” file by double-click it.
Select the “Device Configuration” item. Modify “XOSC Cap Array Delta” to 0x00.

MCUboot
Force VDDR O
Device Configur... 1/1 Enable DCDC
LF XOSC

RF Design
ray Modification

Board I XOSC Cap Armray Delta 0x0

Display /3 Source 48 MHz X0SC_HF

DMA ! rature Com tio |
GFIO 9

3. Save the changes.

4.4.3. Modify RF Switch Configuration

The BDE-MB1354P102 module uses a different RF switch design compared to Tl LP-EM-CC1354P10-6. Follow the
steps below to adjust the RF configuration to fit the module.

1. Open syscfg file.
2. Select “RF” item under “TI DRIVERS”. Modify the RF settings according to the following diagram.
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RF @

None
Use Hardware A The b

RF Antenn
No. of Antenna Switch Control Pins
RF Coexistence
Hardware Interrupt Priority 7 - Lowest Priority
Software Interrupt Priority 0 - Lowest Priority
X0SC Needed

RF_GlobalEventRadioPowerDown, RF_Globe
Global Event Mask

Global Callback Function
functionality must be implemented by the user.
RF Pin Symbols

RF Antenna Pin 0 CONFIG_RF_ANTENNA_PIN_HIGH_PA
RF Antenna Pin 1 CONFIG_RF_ANTENNA_PIN_2_4_G

PinMux Peripheral and Pin Configuration

RF Antenna Pin 0 (Header)

RF Antenna Pin 1 DI028/26 (Header)

3. Save the changes.
4. Right-click the “Startup” folder in the project and create a new C file named “user_rf_switch_cfg.c”.

» E3,Release
~ 3 Startup

main.c

Mew File...

. Mew Folder...
osal_icall_
I Add Files/Folders...
= rom_init.c

B3

simple_peripheral_LP_EM_CC1354P10_6_tirtos7_ticlang/Startup

user_rf_s _cfg.c

5. Copy the following source code to user_rf_switch_cfg.c.
#include <stddef.h>

#include <stdint.h>

#ifndef DeviceFamily CC13X4

#tdefine DeviceFamily CC13X4
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#endif
#include <ti/devices/DeviceFamily.h>
#include "ti_drivers_config.h"
#include <ti/drivers/GPIO.h>
#include <ti/drivers/rf/RF.h>
/*
* ======== rfDriverCallbackAntennaSwitching ========
* Sets up the antenna switch depending on the current PHY configuration.

* Fit BDE-MB13P2 module's switch

* Truth table:

* Path DIO29 DIO28
I
* Off 0 0

* TX 1 0

* RX 0 1

*/

void rfDriverCallbackAntennaSwitching(RF_Handle client, RF_GlobalEvent events, void *arg)

{

if (events & RF_GlobalEventRadioSetup) {
bool sub1GHz = false;

uint8_t loDivider = ©;

/* Switch off all paths. */
GPIO write(CONFIG_RF_ANTENNA PIN 2 4 G, 0);
GPIO write(CONFIG_RF_ANTENNA PIN HIGH PA, 0);

/* Decode the current PA configuration. */

RF_TxPowerTable_PAType paType = (RF_TxPowerTable_PAType)RF_getTxPower(client).paType;

/* Decode the generic argument as a setup command. */

RF_RadioSetup* setupCommand = (RF_RadioSetup*)arg;

switch (setupCommand->common.commandNo) {
case (CMD_RADIO_SETUP):
case (CMD_BLE5_RADIO_SETUP):
loDivider = RF_LODIVIDER_MASK & setupCommand->common.loDivider;

/* Sub-1GHz front-end. */
if (loDivider != @) {
sublGHz = true;
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break;
case (CMD_PROP_RADIO DIV _SETUP):
loDivider = RF_LODIVIDER_MASK & setupCommand->prop_div.loDivider;

/* Sub-1GHz front-end. */

if (loDivider != @) {
sublGHz = true;

}

break;

default:break;

if (!sublGHz) {

/* 2.4 GHz */

if (paType == RF_TxPowerTable_HighPA) {
/* Note: RFC_GPO3 is a work-around because the RFC_GPO1l (PA enable signal) is sometimes not

de-asserted on CC1352 Rev A. */

GPIO_setConfigAndMux(CONFIG_RF_ANTENNA _PIN 2 4 G, GPIO CFG_OUTPUT, IOC_PORT_RFC_GPO0®);
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN HIGH PA, GPIO_CFG_OUTPUT, IOC_PORT RFC_GPO03);

} else {
/* RF core active --> 2.4 GHz */
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_HIGH_PA, GPIO_CFG_OUTPUT, IOC_PORT GPIO);
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA PIN 2 4 G, GPIO_CFG_OUTPUT | GPIO_CFG_OUT_HIGH,

I0C_PORT_GPIO);

}

}
else if (events & RF_GlobalEventRadioPowerDown) {

/* Switch off all paths. */
GPIO write(CONFIG_RF_ANTENNA PIN 2 4 G, 0);
GPIO write(CONFIG_RF_ANTENNA PIN HIGH PA, 0);

/* Reset the IO multiplexer to GPIO functionality */

GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_2 4 G, GPIO_CFG_OUTPUT, IOC_PORT_GPIO);
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_HIGH_PA, GPIO_CFG_OUTPUT, IOC_PORT_GPIO);

4.4.4. Build and Download Project

1. Select Project -> Build All to build the application project.
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File Edit Selection View Go | Project Run Scripts Terminal Help

p EXPLORER: Build Al
1

| % Build Project(s) Curl+8
# OPEN EDITORS

Clean Project(s)
~ BDE-MB1354P102XX

~ Esimple_peripheral_LP_EM_CC SRl E D],
» B3, Generated Source Build Configurations

> B3 Application System Configurations

> COMmMaon :
= Executable Actions

> B3 Drivers
> B icall = Properties... Alt+Enter

2. After building successfully, select Run -> Debug to download the application to the module. If the following
message occur, click “Update”.

Loading Pro
“\Users\bdelNAppData\Local\Temp\ti_cloud_storage\simple_peripheral LP_EM
54P10_6_tirtos7_ticlang.out: PT_LOAD[0]: 32752 of 170176 at 0x0

Cancel

Texas Instruments XD'5110 USE Debug Probe/CS_DAP_0 Warning: A
firmware update is required for the XDS110 probe. The current firrr'uware i-;.
1.-'er5i-:|r1 3.0.0.33. The probe must be u|:u1rﬂd-=d to firmware v
0 I:~ t with this software. Click the "Update® bu1't| n to updatﬂ
T UNPLUG THE DEBUG PROBE DURING THE UPDATE.
|’Emu|ﬂflun pa-_La_;u 20.1.0.3372)

Cancel Update

3. After the update process is finished, click “Continue”.

DEBUG

4.4.5. Running the Demo

1. Open PuTTY, open the serial port with the following settings:
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&2 PuTTY Configuration ? >
Category:

=l Sgassiu:un Basic options for your PuTTY session

- Ten I..Dglging Specify the destination you want to connectin

=} Terminal —
- Keyboard Serial line Speed
- Bel \comi11] | 115200
- Features Lonnectiop fype:

=+ Window OssH | @ Senal |O0ther: | Telnet v
- Appearance
- Behawviour Load, save or delete a stored session
- Translation Saved Sessions
- Selection | |
i Colours

- Connection Load
- Data
-~ Proxy Save

- 55H
: . Delete
- Senal
- Telnet
- Rlogin
- SUPDUP Close window on exit:
(O Mways () Mever (@) Only on clean exit

About Help COpen Cancel

The COM number can be found in the System Device Manager:

i XD5110 Class Application/User UART (COM111)
ALSTITU Ulass Awahary Lrata Fort (LURNTTL]

2. Debug the project and click “Continue” in CCS. The demo will begin execution. The PuTTY will display the
menu as shown below:

3. Open SimpleLink Connect mobile app. Click “Enable BluetoothLE Scan”, and you will see that the module is
advertising.
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Scanner :

Enable BluetoothLE Scan

B/
Available devices: 27
Simple Peripheral _
ﬂ D: 856ETCE1-3A4D-DEEC-BCEL-2FAIDOZFDAEZ -l.II 26 >

@ Advertising =

4. Click the right arrow on the right of “Simple Peripheral” item to connect to the module. After a successful
connection, you will see PUTTY update the information.

EP COM111 - PuTTY

5. Select “Tl Simple Peripheral Service”.

Available services: 2

Device Information

Tl Simple Peripheral Service

- 0xFFFQ _ »

5 characteristics

6. Enable the notification of “Characteristic 4”, the app will receive notification sent by the module.
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Characteristic 4
UUID: OxFFF4

Praperties: Notify

Motifications Enable O

03

7. Write “05” to “Characteristic 3”. PUTTY will print the write information.

Characteristic 3
UUID: OxFFF3

Properties: Write

Write

05

4.5. Host_test Project & Btool Software

Tl provides a PC tool called “btool” to help developers simplify development. Developers can use Btool to scan
and connect to peripheral devices, or to send raw HCl commands.

The directory for Btool is:
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30 _01_01\tools\ble5stack\btool.

Before using Btool, the module must have the host_test application flashed onto it first.

The project directory for host_test is:
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30_01_01\examples\rtos\LP_EM_CC1354P10_6\ble5stack\host_test.

Before building the host_test project, developers should perform the additional steps mentioned in sections 4.4.2
and 4.4.3.

The module will enter DTM mode once the host_test application is flashed. Btool can connect to the module
through UART interface.

The pins used by UART can be found in the following diagram:
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@ host testsyscfg @

& > Software » UART2

MCUboot

Global Parameters Settings that affect all instances
Device Configur...

UARTZ2 (1 Added
RF Design
CONFIG_DISPLAY_UART

Board
Display
DMA
GPID
GPTimer
Power
PWM
RF
RNG
Temperature

Name CONFIG_DISPLAY_UART
Use Hardware

Enable Nonblocking Mode

Data Direction

Flow Control

CIGROIOIOIC)

Interrupt Priority

RX Ring Buffer Siz

TX Ring Buffer Size
Timer
TRNG
Watchdog

TX Interrupt FIFO Threshold
RX Interrupt FIFO Threshold

PinMux Peripheral and Pin Configuration

UART Peripheral y(UARTO)
TX Pin DS110 UART))
RX Pin y(D | 5110 UART))

CICICIOIC N CICICIOIO)

The following steps demonstrate how to operate Btool.
1. Open Btool.
2. Open the serial port with the following settings, and make sure the correct port is selected.

®p Serial Port Settings e
Port: | COMIT1 w
Baud: | 115200 ~
Flaw: | None o
Party: | Mone w
Stop Bits: | One e
Data Bits: |8 w

3. If the hardware functions properly, the following UART logs will be printed.
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[1] : <Info> — 02:40:25_158
Fort opened at 2024/10/22 14:40:25

2] : «T=>» — 02:40:25.237
-Tyvpe : 0201l (Command)
—CplCode : OxFC1D (HCIExt ResetSystemCmd)
—-Data Length : 0xd1 (1) byte(s)

Type o 0=dd (0) (Chip Reset)
Duamp {Tx) =
QoQo:Ql 1D FC OL QO .
[3] : <Rx> - 0Z2:40:25.3584

-Type : 0xd4 (Ewvent)

—EventCode : Ox00FF (HCI_LE ExtEvent)

-Data Length : 0xd5 (5) bytes(s)

Event : 0x041D (1053) (HCIExt ResetSystemCmdDone)
Status : 0x00 ({0) (SUCCESS)

CmdCpCode : OxFC1D (HCIExt ResetSystemilmd)

Dump (Rx) -

QoQo:04 FF O5 1D O4 QO 1DFPC ..

[4] : <Tx= — 02:40:25.903
-Type : 0x01l (Command)
—OpCode : OxFEOO (GAFP_Devicelnit)
-Data Length  0x02 (2) byte(s)

ProfileRole - 0x08 (8) |

Central)

2ddrMode : 0x00 (0) (RDDRMODE_PUBLIC)

Randomiddr = 00:00:00:-00:-00:00
Cump {Tx) -

Q0ad:01 00 FE 08 48 00 90 Qo0 00 00 0O 0O L Liio...
[5] : <Rx> - 0Z:40:25_%30

-Type o Ox04 (Event)

—EwventCode : O0x00FF (HCI_LE ExtEvent)

—-Data Length : 0xd€ (€) bytes(s)

Event : Ox0€7F (1€€3) (GAP HCI ExtentionCommandStatus)
Status : Q=00 (0} (SUCCESS)

4. Developers can scan for and connect to peripheral devices on the “Discover Connect” page.

Select Device Operation @ comi1t
Di
Read Write -~
Pairing Bonding .
Advanced Commands Raad lIl B
Over The Air Download B Ford 0 Max Records:
Scan Scan & Connect Cancel
Connection Settings
ocoMi Min Connection Interval (6-3200): 8015 (100.00ms)
o Pott Info ) -
£ Device Info: Mazx Connection Interval (6-3200): 8013 (100.00ms)
-Handle: DxFFFE Peripheral Latency (0-453): =

-BDAddr: 34:68:B5:2C:96:34 Supervision Timeout (10-3200;: | 2000/ (20000ms)

O ProfileRole:
“Central
Load Settings Get Set
Link Control
Establish Link
Pesrrd 0
Establish Cancel
Link Options

Connection Handle: | (xFFFE PHY Teminate

5. The “Advanced Commands” page provides a variety of HCl commands. For example, developers can send
“HCI_LE_Transmitter_Test” command in the following diagram.
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Select Device Operation

¥ comn

Discover Connect
Read Write
Pairing Bonding

Advanced Commands
Over The Air Download

Pt Info
& Device Info:
Handle: OFFFE

BDAddr: 34:68:B5:2C:56:34

© ProfileRole:
+Central

4.6. TI154STACK

-GATT
GAP

- GAPBondMar
GAP AE

- Ll

=-HCl

~ HCI_Reset
HCI_ReadLocalSupportedFeatures

- HCI_ReadBdAddr
HCI_ReadRSSI

~ HCI_LE_ReadLocalSupportedFeatures
HCI_LE_ReadWhiteListSize

~ HCI_LE_ClearWhiteList
HCI_LE_AddDevice ToWhite List

~ HCI_LE_Remove DeviceFromWhiteList
HCI_LE_ConnectionUpdate

~ HCI_LE_Long TermKeyRequestedReply
HCI_LE_LongTermKeyRequestedNegative Reply

- HCI_LE_ReceiverTest

estl
HCI_LE_RemoteConnectionParameterRequest Reply
~ HCI_LE_RemateConnectionParameterRequestNegative Reply
HCI_LE_SetDatalength
~ HCI_LE_SetResolvablePrivate Address Timeout
HCI_LE_ReadMaxDatalength
- HCI_LE_ReadPhy
HCI LE SetDefaultPhy

oplode ZUTE
txChanne! 0
testDatalength 0
testData 00

opCode
HCI_LE_Transmitter Test

Send Command

TI’ sroyalty-free Tl 15.4-Stack is a complete software platform for developing applications that require extremely
low-power, long-range, reliable, robust and secure wireless star-topology-based networking solutions. This
section describes how to use the Tl 15.4-Stack projects with CCS.

To demonstrate the Tl 15.4-Stack demos, two modules are required.

4.6.1.

1.
2.

Open the CCS IDE.
Go to File -> Open Folder.

Import Projects into CCS

BDE Technology Inc.
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3.

4.

File Edit Selection View

@ E3 Create New Proj

E5 Import Proj

Mew Text File
New File...

New Folder...

Cpen File...
Open Folder...
Open V

Open Recent Workspace...

[ Exit

Select a custom path as the workspace.

&8 Open Folder

™ <« ccs_workspace » BDE-MB1354P102xx v O

Organize « Mew folder

2 Mame

@ COneDrive

[ This PC
J 3D Objects
[ Desktop
= Documents
; Downloads
J’l Music
=/ Pictures

m Videos

. Local Disk (C:)

<

<space from File...

Go Project Run Scripts  Terminal Help

Ctri+N

Ctrl+Alt+N

Ctrl+0
Ctrl+K, Ctrl+O
Ctrl+Alt+W

Ctri+Alt+R

Ctrl+5S

Cirl+Alt+S

Date modified Type

Mo items match your search.

Search BDE-MB1354P102x

x P

Folder:

Go to File -> Import Project(s).

Select Folder C

ancel
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File | Edit Selection View Go Project Run Scripts Terminal Help
ES Create New

E5 Import Project(s)...

New Text File

New File...

| )ser Stu

Ctrl+0
Ctrl+K, Ctrl+O
Ctri+Alt+W

Open Recen ce... Ctri+Alt+R

Add Folder to W
zonnect your board

Ctrl+S
Ctrl+Alt+5
Auto Save

Preferences > udio™ IDE

B Eat

5. Click “Browse”, navigate to the til54stack folder. The default path is:
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30 01 _01\examples\rtos\LP_EM_CC1354P10_6\ti154stack.

6. Select “collector LP_EM_CC1354P10 6 _tirtos7_ticlang” and
“sensor_LP_EM_CC1354P10_6_tirtos7_ticlang” projects, then click ‘Finish’

Import Projects
Search directory ~ Cti\simplelink_cc13xx_cc26xx_sdk_8_30_01_01\examplesyrtosy Browse ..

Discovered projects

collector_LP_EM_CC1354P10_6_freertos_ticlang

collector LP_EM_CC1354P10_6_tirtos7_ticlang [collectorytirtosMticlang\collector LP EM ...
collector_sm_2_4g_LP_EM_CC1354P10_6_freertos_ticdlang
collector_sm_2_4g_LP_EM_CC1354P10_6 tirtos7_ticlang

collector_sm_LP_EM_CC1354P10_6 freertos_ticlang

collector_sm_LP_EM_CC1354P10_6 _tirtos7_tidang

coprocessor_LP_EM_CC1354P10_6_freertos_ticlang
coprocessor_LP_EM_CC1354P10_6_tirtos7_ticlang

sensor_2_4g P EM_CC1354P10_6_freertos_ticlang
sensor_2_4g_LP_EM_CC1354P10_6_tirtos7_ticlang
sensor_LP_EM_CC1354P10_6_freertos_ticlang

3 sensor_LP_EM_CC1354P10 6 _tirtos7 _ticlang [sensorytirtosT\ticlang\sensor_LP_EM_CC135...

|IIII |IIII | IIII | IIII |IIII | II|I Eﬁl |IIII

Create each project in: BDE-MB1354P102xx

Open” ' to browse and import example projects

Cancel Finish
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7. The two projects will be imported into the IDE.
~ BDE-MB1354P102XX
» F_=|,| collector_LP_EM_CC1354P10_6_tirtos7_ticlang
» F_=" host_test LP_EM_CC1354P10_6_ti ticlang

> Ei,sensor_ LP_EM_CC1354P10_6 ti ']
> EZsimple_peripheral_LP_EM_CC1354P10_6_tirtos7_ticlang

iclang

4.6.2. Modify XOSC Cap Setting

The ‘XOSC Cap Array Delta’ parameter will impact the radio frequency offset. An inappropriate value can affect
the RF performance. Follow the steps below to set the value that fits the module.

Open “collector.syscfg” file by double-click it.
Select the “Device Configuration” item. Modify “XOSC Cap Array Delta” to 0x00.

Force VDDR
Device Configur... 1/1 Enable DCDC
RF Design
Cap Array Modification

Board J X p Array Delta 0x0

Display /3 Al ourc 48 MHz 3

DMA d RF Temperature Compensation O

3. Save the changes.
4. Similarly, modify the “XOSC Cap Array Delta” value in sensor.syscfg.

4.6.3. Modify RF Switch Configuration

The BDE-MB1354P101 module uses a different RF switch design compared to Tl LP-EM-CC1354P10-1. Follow the
steps below to adjust the RF configuration to fit the module.

1. Open syscfg file.
2. Select ‘RF’ item under “TI DRIVERS”. Modify the RF settings according to the following diagram.
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None
Use Hardware

Mo. of Antenna Switch Control Pins
RF Coexistence

Hardware Interrupt Priority

Software Interrupt Priority

X0SC Needed

Global Event Mask

Global Callback Function
functionality must be implemented by the user.
RF Pin Symbols

RF Antenna Pin 0 CONFIG_RF_ANTENNA_PIN_HIGH_PA
RF Antenna Pin 1 CONFIG_RF_ANTENNA_PIN_2_4 G

PinMux Peripheral and Pin Configuration

RF Antenna Pin 0 DI029/27 (Header)
RF Antenna PFin 1 DIOZ8/26 (Header)

3. Save the changes.
4. Right-click the “application” folder in the project and create a new C file named “user_rf_switch_cfg.c”.
w F_=', collector LP_EM_CC1354P10_6_tirk ticlang
» B3 Generated Source
v B application
» B collector New File...

> B3 cui Mew Folder...
» B3 defin Add Files/Folders...
= Mmain.c Reveal in File Explorer

> EyRelease Open in Integrated Terminal

Mew File...

B3 collector LP_EM_CC1354P10_6_tirtos7_ticlang/application

user_rf_switch_cfg.c

5. Copy the following source code to user_rf_switch_cfg.c.
#include <stddef.h>

#tinclude <stdint.h>
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#ifndef DeviceFamily CC13X4

#define DeviceFamily CC13X4

#endif

#include <ti/devices/DeviceFamily.h>
#include "ti_drivers_config.h"
#include <ti/drivers/GPIO.h>
#include <ti/drivers/rf/RF.h>

* ======== rfDriverCallbackAntennaSwitching ========
* Sets up the antenna switch depending on the current PHY configuration.

* Fit BDE-MB13P2 module's switch

* Truth table:

* Path DIO29 DIO28
e
* Off (2] (2]

* TX 1 (2]

* RX (2] 1

*/

void rfDriverCallbackAntennaSwitching(RF_Handle client, RF_GlobalEvent events, void *arg)

{

if (events & RF_GlobalEventRadioSetup) {
bool sub1GHz = false;

uint8_t loDivider = 0;

/* Switch off all paths. */
GPIO write(CONFIG_RF_ANTENNA PIN 2 4 G, 0);

GPIO_write(CONFIG_RF_ANTENNA_PIN_HIGH PA, ©);

/* Decode the current PA configuration. */

RF_TxPowerTable_PAType paType = (RF_TxPowerTable_PAType)RF_getTxPower(client).paType;

/* Decode the generic argument as a setup command. */

RF_RadioSetup* setupCommand = (RF_RadioSetup*)arg;

switch (setupCommand->common.commandNo) {
case (CMD_RADIO_SETUP):
case (CMD_BLE5_RADIO_SETUP):
loDivider = RF_LODIVIDER_MASK & setupCommand->common.loDivider;

/* Sub-1GHz front-end. */
if (loDivider != @) {
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sublGHz = true;
}
break;
case (CMD_PROP_RADIO DIV _SETUP):
loDivider = RF_LODIVIDER_MASK & setupCommand->prop_div.loDivider;

/* Sub-1GHz front-end. */

if (loDivider != @) {
sublGHz = true;

}

break;

default:break;

if (!sublGHz) {

/* 2.4 GHz */

if (paType == RF_TxPowerTable_HighPA) {
/* Note: RFC_GPO3 is a work-around because the RFC_GPO1l (PA enable signal) is sometimes not

de-asserted on CC1352 Rev A. */

GPIO_setConfigAndMux(CONFIG_RF_ANTENNA _PIN 2 4 G, GPIO CFG_OUTPUT, IOC_PORT_RFC_GP0®);
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA PIN_HIGH_PA, GPIO_CFG_OUTPUT, IOC_PORT RFC_GPO03);

} else {
/* RF core active --> 2.4 GHz */
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_HIGH_PA, GPIO_CFG_OUTPUT, IOC_PORT GPIO);
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA PIN 2 4 G, GPIO_CFG_OUTPUT | GPIO_CFG_OUT_HIGH,

I0C_PORT_GPIO);

}

}
else if (events & RF_GlobalEventRadioPowerDown) {

/* Switch off all paths. */
GPIO write(CONFIG_RF_ANTENNA PIN 2 4 G, 0);
GPIO write(CONFIG_RF_ANTENNA PIN HIGH PA, 0);

/* Reset the IO multiplexer to GPIO functionality */

GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_2 4 G, GPIO_CFG_OUTPUT, IOC_PORT_GPIO);
GPIO_setConfigAndMux(CONFIG_RF_ANTENNA_PIN_HIGH_PA, GPIO_CFG_OUTPUT, IOC_PORT_GPIO);

4.6.4. Build and Download Project

1. Select Project -> Build All in the toolbar menu. Both the “collect” and “sensor” projects will be built.
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File Edit Selection View Go Project Run  Scripts Terminal Help

@ EXPLORER Build All
Build Project(s) Ctri+E

» OPEN EDITORS

Clean Project(s)

v BDE-MB1354P102XX
~ ELcollector_LP_EM_CC1354P10.

:::' El-. GEr‘IEr-EItEd Source Bu ild Co rlﬁg u rati|:.n5

Rebuild Project(s)

~ B3 application
» B3 collector
» B9 cui

% B3 defines = Properties... Alt+Enter

System Configurations

Executable Actions

2. Select the “collector” project as the current active project by clicking the “collector” project root directory
in the “Project Explorer” view.
v+ BDE-MB1354P102XX GEOA -
~ . collector_LP_EM_CC1354P10_6_tirtos7_ticlang [Release]
» B3, Generated Source
~ B3 application
> B3 collector
» B3 cui
> B3 defines

3. Select Run -> Debug to download the “collector” application to one of the two modules.

Debug Target 0 - TIXDS110_Connection
Serial Number : XDS00009
Debug Target 1 - Tl 110_Connection

Debug Target 1 - TIXD

4,

Tex 3 'CS_DAP_D Warning: A
firmware update is required for the XDS110 probe. The current firmware is
Version he probe must be upgraded to firmware version 3.0.0.36

atible with this software. Click the "Update” button to update
the firmware. O NOT UNPLUG THE DEBUG PROBE DURING THE UPDATE.
{Emulation package 20.1.0.3372)

Cancel Update
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Loading Program:
sers\bdelhvAppData\Local\Temp\ti_cloud_storage\collector_LP_EM_CC135:
52 of 110994 at Ox0

Cancel

5. After the update process is finished, click “Continue”.

DEBUG

6. Select the “sensor” project as the current active project by clicking the “sensor” project root directory in the
“Project Explorer” view.

v F1.sensor_LP_EM_CC1354P10_6_tirtos7_ticlang [Release]
» B3, Generated Source
~ B3 application
» 3 cui
» B3 defines

7. Select Run -> Debug to download the “sensor” application to the other module.

Debug Target 0 - TIXDS110_Connection
Serial Number : XDS00009

Debug Target 1 - TIX 10_Connection

10_Connection

Debug Target 1 - TIXDS110_Connection

4.6.5. Running the demo

1. Opentwo instances of PuUTTY. Open the correct serial ports separately using the following settings.
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&2 PuTTY Configuration

Category:

—|- Session

=} Terminal

- Keyboard
- Bell

- Features
=1 Window

- Appearance
- Behaviour
- Translation
+- Selection
i Colours

—I- Connection

.. Data

- Prowy

+- S5H

- Serial

- Telnet

- Rlogin

- SLIPDLUP

About

Help

Basic options for your PUTTY session

Specify the destination you want to conne

io

Senal line Speed

[comit1] Il 115200

Lonnectiop IyDe,

(185H | (@) Seral | () Cther: | Telnet

Load. save or delete a stored session

Saved Sessions

Load
Save
Delete

Close window on exit:
() Mlways

(") Never

(®) Only on clean exit

Open

Cancel

The COM number can be found in the System Device Manager:

2. Resetthe two modules by pressing the reset button on the BDE-XDS110 board. PuTTY will display the menu.

3. On the collector terminal side, press the right arrow key on the keyboard twice to switch to the “NETWORK

ACTIONS” menu.

i XDS5110 Class Application/User UART (COM111)

AUSTID Llass Awaliary Uata Port (LUNTTE)

4. Press the enter key on the keyboard to open the “NETWORK ACTIONS” menu.
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5. The “NETWORK ACTIONS” menu has three actions: “FORM NWK"”, “OPEN NWK"”, “CLOSE NWK". You can
switch between these actions by pressing the left/right arrow keys.

6. Switch to “FORM NWK?”, then press the Enter key to form a Tl 15.4 network. By default, the network forbids
other devices from joining.

7. Switch to “OPEN NWK”, then press the Enter key to allow devices to join. At this time, the red LED on the
collector board will blink.

8. On the sensor terminal side, open the “NETWORK ACTIONS” menu and perform the “ASSOCIATE” action.
After a while, the sensor will join the network created by the collector. The red LED on the sensor board will
turn on.

9. On the collector terminal side, press the Esc key to retun to the root menu, then switch to the “APP” menu
and perform the “SEND TOGGLE” action. The red LED on the sensor board will toggle.
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4.6.6. Change to a Different PHY

The PHY settings are located under the ‘Tl 15.4 Stack’ item in the syscfg file.
co LP_E! 54P1 > D

& > Software » T 15.4 Stack
T115.4 Stack @ = REMOVE ALL

Custom Enable Logging O
Tl 15.4 Stack !

TI Wi-SUN FAN Stack

W Solar Managem...
Z-Stack

ice Role

Mon Beacon
Radio Configure PHY settings for radio operations

DMM Based On RF Design LP_EM_CC1354P10_6

Frequency Band
MCUboot

@ @ PFLE®

Regulation Type
Sub-1 GHz Frequency
Device Configur... T e . :
Phy Type 5 ps, 2-GFSK
RF Design ! RF Coexistence Disabled
Custom Phy O
Board
Display
DMA

Network Configure network settings

Developers can change the PHY settings according to their needs.

4.7. Use UniFlash to Download Firmware

In the section above, the method to flash the firmware is through debugging in the CCS IDE.

Tl provides a software tool called UniFlash, which can be used for programming on-chip flash on TI
microcontrollers and wireless connectivity devices.

4.7.1. Configure UniFlash

1. Open UniFlash.
2. Select “CC1354P10".

~ New Configuration
@ choose Your Device

Category: All | C2000 | mmWave | MSP | PGA | Safety | Tiva | UCD | Wireless | Bootloader | Sitara MCU

Q. CC1354P10| X

[ LP-EM-CC1354P10-1 LaunchPad  On-Chip
B | P-EM-CC1354P10-6 LaunchPad  On-Chip
|l cci3s4P10 onchip

3. Select “Texas Instruments XDS110 USB Debug Probe”, then click the “Start” button.
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~ New Configuration

@ selected Device: CC1354P10

Q Selected Connection: 9 Texas Instruments XDS110 USBE Debug Probe

TTECRTEWR AT S TUOVZ U ST Sy STENT TTaCe ErITOTaTor
SEGGER J-Link Emulator
Spectrum Digital XDS560VZ STM LAN Emulator
Spectrum Digital XDS560%2 STM TRAVELER Emulator
Spectrum Digital XDS560V2 STM USB Emulator
Spectrum Digital XDSPRO LAN Emulator
Spectrum Digital XDSPRO USB Emulator
Texas Instruments XDS100v2 USB Debug Probe
Texas Instruments XDS100v3 USB Debug Probe
| Texas Instruments XDS110 USE Debug Probe |
Texas Instruments XDS2xx LAN Debug Probe

Texas Instruments XDS2xx USB Debug Probe
Texas Instruments XDS2xx USB Onboard Debug Probe -

B -

4.7.2. Programming

1. Select “Program” item.

Program

Settings & Utilities
Memory

Standalone Command Line

2. Select the image file prepared for programming. By default, the image file is located in the Release/Debug
folder within the project folder in the workspace.

Flash Image(s)
collector_LP_EM_CC1354P10_1_tirtos7_ticlang.out MD5: 33ea76277267657b15fcd710f3a10280 Size: 1.67 MB | Binary: [] x

@

3. Click the “Load Image” button to begin programming.

Available Action(s) - 1 Image Selected

Load Image Verify Image

4. When programming is successful, the console will display the following information.

[SUCCESS] Program Load completed successfully.
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Please refer to the UniFlash quick start guide for more information about the UniFlash tool. Click the “Help” icon

@ Help L Settings

4.8. SmartRF™ Studio

to open the quick start guide.

SmartRF™ Studio is a Windows application that helps developers to easily evaluate the radio for all TI CC1xxx and
CC2xxx low-power RF devices.

This tool can also be used for RF certification testing.

Visit the link below to download and install SmartRF™ Studio.
https://www.ti.com/tool/SMARTRFTM-STUDIO

SMARTRF-STUDIO-7 — SmartRF Studio 7 application software & Notifications

CALCULATION TOOL Download options

Supported products & hardware

If the installer becomes locked during the download process, follow the instructions provided by TI.

@ smartrftm_studio-2.32.0.zip — 73596 K

4.8.1. Connect to the Module

1. Connect the module to the PC using the XDS debug probe.
2.  Open SmartRF Studio 7.
3.  SmartRF Studio will show that one Sub-1 GHz device is connected.

Smart ™ Studio?7

Sub-1 GHz (1 Connacted)
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4. Double-click the “CC1354P10” item.

5. Select the mode you want; in this example, the “Proprietary mode” is selected.

354P10 mode

QO Proprietary mode

@ BLE mode
@ [EEE 302.15.4 mode

6. After clicking OK, SmartRF Studio will open a new window called “Device Control Panel”.

L8 XDs-XDS00092 - CC1354P10_PROP - Device Control Panel

File Settings View Evaluation Board Help

P stat M Stop | ] Command View [l RF Parameters

Target C:

RF Design Based On: | LP_CC1354P10_1_RGZ - @ DC/DC Enable

Typical Settings

= Settings for 779 - 930 MHz band
50 kbps, 25 kHz Deviation, 2- 0 kHz RX Bandwidth

D Cap-array Tuning ﬁ

IEEE 802.15.4, 50 kbps, 25 kHz Deviation, 2-GFSK, 100 kHz R Bandwidth

100 kbps, 25 kHz Deviation, 2-GFSK, 137 kHz RX Bandwidth
200 kbps, 50 kHz Deviation, 2-GFSK, 311 kHz RX Bandwidth

Customize...

RF Parameters ﬁ

915.00000 MHz 50.00000 kBaud 25.000

RX Filter BW TX Power
kHz _ dBm Enable high output power ﬁ Mo whitening

Continuous TX | Continuous RX | PacketTX | packet RX

Packet Count: D Infinite
Length Config

Length
(dec)

Packet Data

Preamble Sync word

01010101... ||[[93][ab |[51][de | [5 1] 875 ae 00 82 1c o8 03 o 4a 13 43 cd a8 8a 67 8e 21

Preamble Count: Sync Word Length: [ Address

Preamble Mode: |Send 0 as the first preamble bit - |

Add Seq. Number

(® Random | 4575 se 00 8a 1c c6 d3 fb 4a 19 43 cd a9 9a 67 8e 21
O Text

() Hex

CC1354P10_PROP, Rev. C (3.0), XDS-XDS00092 XDS110

4.8.2. Change the Default Settings

1. Select “LP_EM_CC1354P10_6" or “LP_CC1354P10_6, 20DBM”.

&

™

Sent Packets:
Freguency:
Qutput Power:

Start

Radio State: N.A.

Target Configuration

RF Design Based On: [LP_CC1354P10_1_RGZ

Typical Settings

Category

LP_CC1354P10_1_RGZ
LP_EM_CC1354P10_1
LP_EM_CC1354P10_6

LP_EM_CC1354P10_§, 200BM

Setting Name
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Select “Cap-array Tuning” and modify the “Cap Array Delta” to 0.

Cap-array Tuning Cap Array Derta: Ox00
Select the PHY setting.

Typical Settings

+ Settings for Bluetooth Low Energy
BLE, 2 Mbps, LE 2M
BLE, 500 kbps, LE Coded
BLE, 125 kbps, LE Coded

Select the “BLE Channel” or “Frequency” and “TX Power”.

RF Parameters (&)

BLE Channel Frequency
0 v HHz Ml whtenng 20~ dBm

Click “Customize...” button to open the “Custom Target Configuration” window.

Target Configuration

RF Design Based On: | LP_EW_CC1354P10_6, 20080 ~ | @) DC/DC Enable [ cap-array Tuning CapArrayDena 0x00 @

Enable high output pov

Modify the I/O configuration according to the following diagrams. Click “Apply” and then click “Close”.

&0 custam Target Configuratian *

Target Selection

Basic Configuration (T Target)

LP_EM_CC1354P10_6, 200BM - Target Name |LP_EM_CC1354P10_8, 200BM |

Device CC1354P10 ¥ | Package RSKExE +

New Delete Create Copy As...

Front-end External Bias, Differential RF -
VO Configuration I Output Power
O Signal Configuration

L e %
DIOZ8 * | | Input/Output ¥ | |Input tristate (Default) | | Output low T | Output high | [X
DIOZ29 * | | Input’Output * | |Input tristate (Default) | | Output high * | Output low | [X
<Select I0= -
V0= not defined here are not configured and remains in their reset state. Apply Undo
Save Close Help

1/0 configuration with PA enabled

BDE Technology Inc. 43 | 47

info@bdecomm.com



—
BDE-MB1354P102 Module User Guide LB})E'

&8 Custom Target Configuration

X
Target Selection Basic Configuration (T1 Target)
a54 g 2
LP_EM_CC1354P10_6, 200BM - Target Name |LP_EM_CC1354P10_8, 2008 |
Device CC1354P10 *  Package |[RSK8x8 ~
New Delete Create Copy As...
Front-end External Biaz, Differential RF o
VO Configuration I Cutput Power
O Signal Configuration
Idle X RX
DIoza * | | Input/Cutput w | |Input tristate (Defaulty | | Output high * | | Qutput high * | X
DIozg * | | Input/Output * | |Input tristate (Defaulty = | | Output low * | | Qutput low * | X

<5elect V0= -

0= not defined here are not configured and remains in their reset state. Apphy Undo

Save Close Help

I/0 configuration with PA disabled

4.8.3. Perform RF Test

RF testing is divided into continuous TX/RX and packet TX/RX. The signal duty cycle is 100% when operating in

continuous mode. The following steps use continuous TX as an example to demonstrate how to start the RF test.
1. Click “Continuous TX".

Continuous TX §| Continuous RX | Packet TX | Packet R

2. Enable or disable modulation of the transmitted signal. When the “Unmodulated” radio box is selected, the

signal is a carrier wave.
() Modulated (® Unmodulated

3. Click “Start” to start transmitting the RF signal.

Output Power: 20 dBm
Channel: 0

[
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NOTE: Each time the RF testing type or “Enable high output power PA” setting is changed, the I/0O configuration
must be reconfigured.

@
Please refer to the help document for more information about the SmartRF Studio tool. Click icon E&E to open
the “SmartRF Studio Help” window, then click the “Browse Complete Help Document--+” button to access the
help document.

&l SmartRF Studio Help X

Help

The SmartRF Studio Startup Window shows an | h
overview of all available RF devices and
indicates which of them are physically
connected.

Right click on the device icon to access .
additional infermation about the device. wlroml S ries S e

Double click on the device icon to start Device SmartRf Studio 2.30.0 (e

Control Panel for the RF Device. SmartRF Studio i= a tool that lets
customers evaluate, test and configure
Low Power RF devices from Texas
Instruments. It iz in particular useful for
generating chip specific register values
and for finding and tuning RF parameters.

If wou have any questions or want to give
feedback on SmartRF Studio, please visit
support.ti.com.

This software iz developed by Texas
Instruments to the courtesy of our
customers.

SmartRF Studio will not target Automotive
customers since it is not gualified for
Browse Complete Help Document... Automotive devices. Customers may use
SmartRF Studie 7 for autometive devices,
Revision History... but it is the customer's responsibility to
ultimatety comphy with regulatory
requirements.

Distribution and Disclaimer...

Copyright (c) Texas Instruments
Check for Updates...

Close

5. Other Resources

Access more documents by visiting the TI CC1354P10 page at the link below.
https://www.ti.com/product/CC1354P10

Additionally, refer to the guides for different components for more information about the Simplelink SDK. The
guides are located in the directory below:
C:\ti\simplelink_cc13xx_cc26xx_sdk_8 30 _01_01\docs

For other related documentations of the module, please visit the module product page at bdecomm.com.

6. Ordering Information
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Table 3. Ordering Information

Product Type

Orderable Part Number

Description

Evaluation Kit

BDE-MB1354P102xxx-K1

Evaluation kit 1 for module BDE-MB1354P102xxx, includes
1x BDE-MB13-BO, 1x BDE-LPEM, 1x BDE-XDS110, 1x USB
type C cable. Refer to module datasheet for module
variants. For example, BDE-MB1354P102UA0-K1 is the
evaluation kit 1 for module BDE-MB1354P102UAQ

Module Breakout Board BDE-MB13-BO Breakout board with BDE-MB1354P102module
Interface Evaluation Module | BDE-LPEM Launchpad evaluation module with BoosterPack interface
Debugger BDE-XDS110 XDS110 debugger

7. Revision History

Table 4. Revision History

Revision

Date

Description

V1.0

2025-5-27

First release

8. Additional Information

8.1. Trademarks

Bluetoothe s a registered trademark of Bluetooth SIG, Inc.

Launchpad™ is a registered trademark of Texas Instruments.

BoosterPack™ is a registered trademark of Texas Instruments.

SmartRF™ is a registered trademark of Texas Instruments.

All trademarks are the property of their respective owners.
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Important Notice and Disclaimer

The information contained herein is believed to be reliable. BDE makes no warranties regarding the information
contain herein. BDE assumes no responsibility or liability whatsoever for any of the information contained herein.
BDE assumes no responsibility or liability whatsoever for the use of the information contained herein. The
information contained herein is provided "AS IS, WHERE IS" and with all faults, and the entire risk associated with
such information is entirely with the user. All information contained herein is subject to change without notice.
Customers should obtain and verify the latest relevant information before placing orders for BDE products. The
information contained herein or any use of such information does not grant, explicitly or implicitly, to any party
any patent rights, licenses, or any other intellectual property rights, whether with regard to such information
itself or anything described by such information.

Contact
BDE Technology Inc.

USA: 67 E Madison St, # 1603A, Chicago, IL 60603, US
Tel: +1-312-379-9589

China: B2-403, 162 Science Avenue, Huangpu District, Guangzhou 510663, China
Tel: +86-20-28065335

Website: www.bdecomm.com Email: info@bdecomm.com
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